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These instructions cover operating the Rigaku RU300 X-ray generator and using the data collection software.  
 
There are two diffractometers attached to the RU300 X-ray generator, commonly referred to as the left-hand side 
diffractometer (aka the 250mm goniometer) and right-hand side diffractometer (aka the 185mm goniometer).  
 
The right-hand side diffractometer has a 185mm radius goniometer. This provides high intensity, which is useful for faster 
data collection or for examining small quantities of sample. However, this diffractometer has lower resolution and is more 
susceptible to error in peak positions due to systematic aberrations. 
 
The left-hand side diffractometer has a 250mm radius goniometer. This provides higher resolution and more accurate peak 
positions, but less intensity thus requiring longer scan times.    
 
If there is any problem with the generator or diffractometer, you are required to report it  to Scott 
Speakman (13-4009A, x3-6887) immediately. If the problem poses a safety hazard, turn off the 
generator (even if a scan is in progress) and post a note on the enclosure (so that no one else tries to use 
the instrument). Remember, you are not just responsible for your own safety; you are also responsible for 
the safety of those around you. 
 
The outline for these instructions is: 

I. Preliminary Checks 
II. Entering the Enclosure when X-Rays are On  

 III. Setting up the Diffractometer 
 IV. Turning on the X-Ray Generator 
 V. Using the Data Collection Software 
 VI. When Your Run is Finished 
 Appendix A. Selecting Slits for your Experiment 
 Appendix B. Typical Scan Parameters and Strategies 
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Operating Instructions: Quick Sheet 
This simpler instruction list is intended as a reminder/checklist for the experienced user. New users should refer to the more 
detailed instructions starting on page 5 until more familiar with the instrument. 
 
I. PRELIMINARY CHECKS 
1) Determine whether the X-ray generator is ON or OFF 

a) If the X-rays are OFF, you may enter the enclosure and proceed.  
b) If the X-rays are ON  

i) Check if either shutter is open.  
(1) If your shutter is open, you must wait until it closes before proceeding. 
(2) If NO shutters are open, turn off the generator and proceed to section II. 
(3) If the shutter on the other side is OPEN, proceed to Section I.2, 

“Entering the Enclosure with X-rays ON” 
 

2) Entering the Enclosure with X-rays ON 
You may open the enclosure doors when the X-rays are ON when: 

o a scan is in progress on the other diffractometer and it will not end soon  
o your shutter is closed 
o the lead-covered clear-PVC separator is between the two diffractometers. 

a) Check that your shutter is closed.  
b) Turn the FS RELEASE key (fail safe release) 
c) Survey the area around the diffractometer with the portable Geiger counter.  

i) Check the battery of the Geiger counter 
ii)  Use the lowest setting (highest sensitivity), with the knob turned to the 

x0.1 scale multiplier. 
iii)  Survey the area around the diffractometer 
iv) If the intensity at any point is more than 0.05 mR/hr, immediately close 

the enclosure, turn off the generator, and contact Scott. 
v) If the intensity is less than 0.05 mR/hr, then you may proceed to section II. 
vi) Turn off the Geiger counter (turn knob CCW) after you have surveyed the instrument. 

 
II. SET UP THE DIFFRACTOMETER 
1) Check the slits  
2) Insert the sample and place the anti-scatter cover on the sample chamber. 
3) Close the enclosure doors.   
 
III. TURN ON THE X-RAY GENERATOR 
If another person is inserting a sample or soon will be, wait until they are done before turning on the generator.  
1) Press the white T-REV button. 
2) The amber READY light on the generator control panel should light up brightly 

a) If the READY light does not light up, or lights up only dimly, then check: 
i) that all enclosure doors are properly closed. 
ii)  that the voltage and current dials are turned fully counterclockwise to 

their minimum positions. 
iii)  If correcting these does not cause the amber ready light to light up, 

contact Scott immediately. 
3) Press the white ON button.   

a) Wait for the voltage (kV) meter to settle at 20kV and the current (mA) meter to settle at 20mA. 
4) Turn up the generator power.  

a) Use only the coarse adjust dials for kV and mA. 
b) First turn up the kV slowly to 50 kV, waiting for the gauge to settle between each detent. 
c) Then turn up the mA slowly to 300 mA, pausing between each detent (i.e. click).  

 
IV. USING THE DATA COLLECTION SOFTWARE 
1) Start MDI DataScan4 
2) Initialize the Diffractometer 

a) Open Control > Rigaku D/Max-b 
b) In the Goniom tab, set the “2Theta”  and “Theta”  offsets and click the Datum button. 

REMEMBER: 
o If you are the only person 

using the instrument, turn 
off the X-rays every time 
you enter the enclosure 

o X-Rays should be on, and 
the shutters open, only when 
data is being collected. 

o Each shutter has a pair of 
“Shutter Open” Warning 
Lights. If you ever see one 
light on and the other off, 
turn off the generator (even 
if a run is in progress) and 
contact Scott. 

You must survey the instrument 
every single time that you enter 
the enclosure while the generator 
is on. This is to protect you from 
accidents such as a stuck shutter 

If any alarm indicator lights on the 
Generator Control Panel illuminate, 
accompanied by the generator 
shutting off, contact Scott 
immediately. Do not continue to 
attempt to operate the instrument.  
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c) In the PHA tab, set the “Base Line”, “Window” , and “Detector HV”  values and then click all 3 Set 
buttons. 

3) Set up the Scan Parameters 
a) Go to Scan > Routine Scan… 

i) Edit the Task List 
(1) Define the Output Directory 

ii)  Edit the Scan Job 
(1) Define the Filename and Sample ID (Comment).  

iii)  Define the Scan Parameters 
4) Start the Scan 
5) Correcting problems with data collection software 

a) If the computer seems to hang or you get error messages that you do not understand use the following instructions to 
correct any problem. 
i) Quit DataScan 
ii)  Reset the Rigaku controller electronics 

(1) On the floor to the right of the data collection computer is a green cabinet. 
(2) Open the door to this cabinet. 
(3) Find the RESET switch in the nim-bin on the right-hand side of the cabinet. 
(4) Toggle the Reset switch 

iii)  Restart DataScan 
iv) If you are still having problems, REBOOT the data collection computer. 
v) Be sure to Initialize the Diffractometer before collecting data again. 

 
V. WHEN YOUR RUN IS FINISHED  
1) While you do not need to remain in the XRD lab while your data is being collected, you must be present when your run 

finishes. 
2) Turn off the X-ray generator 

a) If the other side is not in use, you must turn off the X-ray generator when your run is finished. 
b) First, slowly turn down the current (mA) 
c) Then, slowly turn down the voltage (kV) 
d) Press the red OFF button on the generator control panel. 

3) Remove your sample from the diffractometer 
a) Leave the cap OFF of the sample scatter shield 

4) Close the enclosure doors. 

During the summer, instructions 
may be posted to leave the generator 
on at 30 kV and 100 mA to prevent 
condensation on the tube tower. 
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Operating Instructions: Thorough & Illustrated  
 
I. PRELIMINARY CHECKS  
 
1) Determine whether the X-ray generator is ON or OFF 

a) This is indicated by the red warning light hanging above the tube tower and the red 
warning light on the generator control panel (labeled X-RAY).  

 
2) If the X-rays are NOT ON, proceed to Section II “Setting up the Diffractometer” 
 
3) If the X-rays are ON  

a) Check if either shutter is open. This is indicated by: 
i) The red warning lights on either side of the tube tower 
ii)  The red warning lights on the shutter control panel. 

(1) The lights are labeled Shutter 1 (for the left-hand side) and 2 (for the right-hand side)  
iii)  The X-ray safety shutters can open only when the X-ray generator is on. 

b) If the shutter on your side is open, you must wait until the run finishes and it closes. 
 

c) If NO  shutters are open, then turn off the generator and proceed to Section II. 
i) See Section V “When Your Run is Finished” for instructions on turning off the generator 
ii)  If no scan is running, you must turn off the generator every time you enter the enclosure (e.g. to 

change samples).  
 

d) If the shutter for the diffractometer on the other side is OPEN 
i) Determine when the current scan will end.  
ii)  If it will finish soon, wait until the scan is done, turn off the generator, and proceed to Section II.  
iii)  If the experiment will not end shortly, then proceed to Section I.4, “Entering the Enclosure when 

X-rays are ON” 
 

PLEASE NOTE: 
�  If you are the only one using the X-ray generator, you must turn off the X-rays every time you enter the enclosure 

�  Remember, when you enter the enclosure while the generator is on you are putting yourself at the greatest risk of 
receiving an exposure to X-radiation. Turning off the generator whenever possible helps to ensure your safety.   

�  X-Rays should be on, and the shutters open, only when the diffractometers are collecting data. 
�  Never operate the shutters from the switches on the shutter control panel. 
�  If you ever observe, for the pairs of warning lights for either shutter or for the X-ray generator, one warning light on and 

the other warning light off, turn off the generator (even if a run is in progress) and contact Scott or Peter immediately. 
 

4) Entering the Enclosure when X-rays are ON 
a) You may open the enclosure doors when the X-rays are ON, only under the following conditions: 

i) the diffractometer that you are not using is being used by another person and the scan in progress on that 
diffractometer will not end soon.  

ii)  your shutter is closed 
(1) The warning lights on both the tube tower and on the shutter control panel must be off. 

iii)  the lead-covered clear-PVC separator is between the two diffractometers and pressed up against the 
tube tower. 

 
b) Check that your shutter is closed.  
 
c) Turn the FS RELEASE key (fail safe release) 

i) Opening the enclosure doors without turning the FS Key will cause the generator to turn off.  
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d) Survey the area around the diffractometer with the portable Geiger counter.  

i) Check the battery of the Geiger counter 
(1) Turn the knob from O (off) to B.  
(2) Look at the needle on the lowermost scale (labeled BAT TEST).  
(3) Make sure that the needle is above the lowermost mark on the BAT TEST scale. 

ii)  Turn the Geiger counter knob to the lowest setting, x0.1 
iii)  Make sure that the audible alarm is on 

(1) Make sure that the switch labeled AUD, on the left-hand side of the Geiger counter and just below the meter, 
is in the ON position.  

iv) Test the meter 
(1) Hold the detector next to the radioactive foil on the left-hand side of the Geiger counter 
(2) The needle should move off of the scale and the audible alarm should sound nearly continuously. 

v) Open the enclosure door only enough so that you may reach in with the Geiger detector. 
vi) Survey the area around the diffractometer, specifically: 

(1) Around the X-ray port and shutter assembly in the tube tower 
(2) Around the separator shield between the two diffractometers 
(3) Around the sample holder 

vii)  If the intensity is the same as the background, i.e. less than 0.05 mR/hr (0.5 on the middle scale when the 
multiplier is set to x0.1), then  
(1) Record the intensity reading in the log book on the table in the middle of the room. 
(2) you may proceed to section II, “Setting up the Diffractometer”. 

viii)  If the intensity at any point is more than 0.05 mR/hr, immediately close the enclosure, turn off the generator, and 
contact Scott or Peter. 

ix) Turn off the Geiger counter after you have surveyed the instrument (turn the knob all the way CCW to O). 
 
NOTE: You must survey the diffractometer every single time that you enter the enclosure while the 
generator is on. This is to protect you from accidents such as a stuck shutter.  
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II. SETTING UP THE DIFFRACTOMETER  
 

1) Check the slits  
a) DO NOT ASSUME that the last person to use the diffractometer used the slits that you need. 
b) Use Appendix A to help you decide what slits to use. 
c) Check the divergence slit (DS).  

i) The DS is the slit closest to the tube tower.  
ii)  The DS is covered by an anti-scatter cap that you must remove.  

(1) Be sure to replace the anti-scatter cap after checking/changing the DS.  
iii)  All divergence slits are labeled with DS and the slit size. 

d) Check the scatter slit (SS) 
i) The SS is the first slit in the diffracted beam path, closest to the sample. 
ii)  The SS should be the same as the DS.  
iii)  All scatter slits are labeled with SS and the slit size. 

e) Check the receiving slit (RS).  
i) The RS is located between the receiving soller slits and the monochromator.  
ii)  All receiving slits are labeled only with the slit size. 

f) Check the monochromator receiving slit (RSM) 
i) The RSM is located between the monochromator and the detector. 
ii)  All RSM’s are labeled only with the slit size. 
 

2) Insert the sample. 
a) After inserting the sample, check that it is tight up against the sample post.   

i) Make sure that both springs are behind the sample holder. 
ii)  If the sample holder is loose, the measured angles may not be correct.   

b) Place the cover on the sample scatter shield  
i) Make sure that the microswitch is depressed by the flat tab on the cover. 
ii)  The shutter will not open during data collection if this cover is not properly placed. 

 
3) Close the enclosure doors.   

a) Line up the white metal plates on the doors with the red dots on the enclosure frame. 
b) Make sure that the left- and right-hand doors are closed as far as they can go. 
c) For the center door, line up the white metal plate in the left lower corner of the center door with the red dot on the rail. 

i) Hint:  if the generator is on, it is very easy to cause it to turn off by incorrectly closing the center door. To make it 
easier, slightly open the left-hand door, push the center door into the closed position, and then close the left hand 
door.     

 
4) If the generator is off, proceed to section III “Turning on the X-ray Generator”; if the generator is on, proceed to 

section IV, “Using the Data Collection Software” 
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III. TURNING ON THE X-RAY GENERATOR  
 
1) Before turning on the X-ray Generator 

a) Check if someone else is in the process of inserting/changing samples on the other side of the diffractometer. 
i) If another person is inserting a sample or soon will be, wait until they have inserted the 

sample and closed the enclosure doors before turning on the generator.  
 

2) Press the white T-REV button. 
a) The belt drive should begin spinning the anode. 
b) The amber READY light on the generator control panel should light up brightly 

i) If the READY light does not light up, or lights up only dimly, then: 
(1) Check that all enclosure doors are properly closed. 
(2) Check that the voltage and current dials are turned fully counterclockwise to their 

minimum positions. 
(a) Voltage and current each have 2 dials: a coarse adjust dial and a fine adjust dial 

(3) Check the status of the tube vacuum. The three green lights on the vacuum 
controller, labeled 10-3, 10-4, and 10-5 are lit. The gauge should be reading less than .200 
(a) If only one or two lights are on, do not turn on the generator. Report this to Scott immediately. 

ii)  If correcting these does not cause the amber ready light to light up, contact Scott 
 

3) Press the white ON button.   
a) Wait for the voltage (kV) meter to settle at 20kV and the current (mA) meter to settle at 10mA.. 

 
4) Turn up the generator power.  

a) First turn up the kV slowly.  
i) Turn the coarse adjust dial one ‘click’ at a time, waiting for the meter to settle at the new kV before turning the 

dial to the next detent. 
(1) Use only the coarse adjust dial.  

b) Then turn up the mA slowly, pausing between each detent (i.e. click).  
(1) Use only the coarse adjust dial 

c) The kV and mA settings depend upon your sample and the counting statistics you require.   
i) The generator is typically run at the maximum power of 50kV and 300mA (18 kw). 
ii)  Because of the age of the generator, sometimes it cannot be run at full power. In such a situation, the maximum 

power will be posted by the generator control panel.  
 
NOTE: If any of the alarm indicator lights on the Generator Control Panel illuminate, 
accompanied by the generator shutting off, contact Scott or Peter immediately. Do not continue to 
attempt to operate the instrument.  
 



 9

IV. USING THE DATA COLLECTION SOFTWARE  
Data from the Rigaku RU300 diffractometers are collected with MDI DataScan v.4. This program follows most of 
the conventions for Windows-based programs. Conventions used in this guide to describe the software are: 

·  Menu items are printed in italics, for example: File, Edit, etc 
·  Nested menus and selections within menus are indicated by >, for example File>Open, Control>Preferences 
·  Window titles (shown in the blue title bar of each window) are written in bold italics. 
·  Names of tabs are underlined. 
·  Icons or Buttons on a dialogue box that you should click are shown in bold, for example: OK¸Apply  
·  All fields are shown in bold between “quotation marks” .  

See Appendix B for notes on selecting scan conditions and data collection strategies.  
 
1) Start MDI DataScan4 if it is not already running. 
 
2) Initialize the Diffractometer 
Before data can be collected, the goniometer must be initialized and the detector turned on. For Rigaku 
diffractometers, this is known as ‘Datum the goniometer’ and ‘Set HV/PHA’.  

····  This only needs to be done once per session. 
····  The datum offsets and HV/PHA values are posted on the monitors of the data collection computers. 
····  The datum offsets and HV/PHA values are not the same for the left- and right-hand side diffractometers. 

 
a) Open Control> Rigaku D/Max-b 

i) The Rigaku D/Max-b control window will open. 
 
 
 
 
b) To initialize the goniometer 

 
i) Go to the Goniom tab.  
 
ii)  Make sure that the offset values for “2Theta”  and 

“Theta”  correspond to those posted on the 
monitor. 

 
iii)  Click the Datum button. 
 
 
 
 
 
 
iv) In the resulting dialogue window, click OK 

.  
 
 
 
 
v) It may take a minute or two for the Datum to complete. You will know it is done by the message in the 

lower left portion of the screen, which will read “Datum completed.” 
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c) To turn on the detector  
 
i) Go to the PHA tab in the Rigaku D/Max-b control window. 
 
ii)  Make sure that the values for “Base Line”, “Window” , and 

“Detector HV”  correspond to those posted on the monitor of 
the data collection computer.  

 
iii)  Click SET for all three PHA properties: Base Line, Window, 

and Detector HV.  
 
 
 

 
 

d) After you have configured the diffractometer, close the Rigaku D/Max-b control window. 
 
3) Set Up the Scan Parameters 
DataScan includes two components that define how data will be collected.  

·  Scan Job: specifies parameters, such as scan range, speed, etc., for collecting the XRD data. A single scan 
job may include several different ranges, which is useful if you want to collect several short scan segments 
rather than one long scan (see Appendix B for more information). All data collected with a single scan job 
is saved under a single filename. For the Rigaku, scan jobs will typically contain just a single item. 

·  Task List: a list of scan jobs that will be collected in order. This is most useful if the diffractometer has a 
sample changer, which ours doesn’t. Useful on the Rigaku if you want to collect multiple scans from the 
same sample, or multiple short scan segments, and save each one with a different filename. Again, a typical 
task list for the Rigaku will contain a single line for a single scan job. 

 
While you can create a new data collection program every time you collect data, DataScan is designed so that you 
can save a task list as a *.jrx file and load it every time you want to collect data using those scan parameters 
  

a) Go to Scan> Routine Scan … 
i) This will open the Setup Scans window 

that contains the task list. 
 

 
 
 
b) Edit the Task List 

When the Setup Scans window opens, it may be empty or it may contain a list of scan jobs. You need at 
least one scan job in the task list to define the data collection parameters. 
i) If the task list contains a scan job that defines the parameters that you want to use, then you can just 

change the filename (“File ID” ) and sample description (“Comment” ) and start data collection. 
ii)  To load a saved task list (a *.jrx file), click on the Load Task icon. 

(1) Be sure to change the filename and sample description before collecting data. 
iii)  Click on the New Scan Job icon to create a new scan. 

(1) This will open the New Scan Job window, where you can edit scan items. 
(2) If no pre-existing scan is listed, there may also be a New Scan Job button in the task list. 
(3) If there is already a scan job in the task list, clicking on the New Scan Job icon will add a second scan job to 

the list. If you want only one scan job, you should edit or delete the existing job.  
iv) Click on the Edit Scan Job icon to edit an existing scan.  

(1) This will open the New Scan Job window, where you can edit scan items. 
(2) If there is no pre-existing scan, this option may not be available.  
(3) You can also double-click on a scan job in the task list to edit it. 
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c) Edit the Scan Job 
i) When you choose to create a new scan job or edit a scan job, the New Scan Job window will open. It 

may be empty or it may contain a list of scan items. 
ii)  Click on the New Item icon to create a new item defining the scan range and parameters. 

(1) If no scan parameters were automatically loaded into this window, there may also be a New Range button. 
(2) If there is already an item in the scan job, clicking on the New Item icon will add a second item to the list. If 

you want only one scan, you should edit or delete the existing scan item.  
iii)  To edit scan parameters, click on the Edit Item icon or double-click on the line in the scan job list. 
iv) The New Scan Range window will open.  

 
 

Create a new 
scan job 

Edit scan job 
property 

Delete a scan job 
from the task list 

Load a saved 
task list 

Create a 
New Item 

Delete an Item Edit an Item 

The Setup Scans window will 
usually list no job if DataScan has 
just been started (above). If 
DataScan has been running, the 
Setup Scans window will often 
show the parameters from the 
previous scan (left). 
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d) Define the Scan Parameters 
i) In the New Scan Range window, you can define the scan parameters. 
ii)  You MUST make sure that the scan range is evenly divisible by the step size:  

(1) for example, if using a step size of 0.3, then a scan range from 20 to 40 degrees 2theta (20 deg scan 
range) would produce an error, while a scan range from 20 to 50 degrees 2theta (30 deg scan range) 
would be ok.  

iii)  The minimum start angle is 2 degrees 2theta.  
iv) The maximum end angle is 107 degrees 2theta.  

(1) With special precautions, the maximum scan angle can be increased to 139 degrees (right-hand 
side) or 154 degrees (left-hand side). Talk to Scott if you need to collect data at these higher angles.  

v) The scan parameters are slightly different for a continuous scan and a step scan.  
vi) Appendix B defines the various parameters and offers suggestions for data collection.  
vii)  Click OK 

   
 

 
 
e) Set Filename, etc. 

i) After closing the New Scan Range window, the New Scan Job window will be active. 
ii)  Set the filename in the “Data File ID”  field and a description of your sample in the “Comment”  field. 
iii)  Click OK to close the New Scan Job window. 

 
f) Set the Output Directory 

i) After closing the New Scan Job window, 
the Setup Scans window will be active. 

ii)  Click on the Browse button to set the 
folder where your data will be saved. 

iii)  You can edit the filename and sample 
description in this window by clicking 
on, and editing, the “File ID”  and 
“Comment”  fields.   

 
 
 
 

g) Start the Scan 
i) Click on the Start button (in the bottom 

of the Setup Scans window) to begin data 
collection. 

ii)  Click OK on the resulting dialogue 
 
 
 
 

New Scan Range window for a continuous 
scan. 

New Scan Range window for a step scan. 
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h) During the Scan 
i) Datascan will display the data in real time as it is collected.  
ii)  Data are saved as a *.mdi ascii file.  
iii)  The data are automatically saved after every 100 data points, and at the end of the scan. 
iv) The Scan Progress title will show the %completion of the current scan. By floating the mouse pointer 

over this display, a yellow text box will appear showing the time left before the scan is finished.  
v) The bottom bar of the display window shows information such as the current detector angle, the 

filename of the data being collected, the scan parameters of the current scan, etc. 
vi) You can zoom in the realtime display window by left-click and dragging.  
vii)  You can stop a scan in progress: 

(1) Click on the Stop icon 
(2) Click OK in the resulting dialogue 
(3) You can save the partially completed diffraction pattern by going to File>Save Data As 

 
 
4) Correcting problems with data collection 

a) If the data collection seems to hang or you get error messages that you do not understand, use the following 
instructions to correct any problem. 
i) Close DataScan. 
ii)  Reset the Rigaku controller electronics 

(1) Open the door to the green cabinet underneath the monitor of the data collection computer.  
(2) Find the RESET switch in the NIM-BIN on the right-hand side of the cabinet. 
(3) Toggle the Reset switch 

iii)  Start DataScan again. 
(1) Reinitialize the goniometer and detector (datum the goniometer and set HV/PHA as described in 

Section IV.2)  
 

Stop Scan 

Current Detector 
Position 

Scan 
Progress Bar 

Right-click 
here for view 
options 



 14 

V. WHEN YOUR RUN IS FINISHED  
 

1) While you do not need to remain in the XRD lab while your data is being collected, you must be present when 
your run finishes. 

2) Turn off the X-ray generator 
a) If the other side is not in use, you must turn off the X-ray generator when your run is finished. 
b) First, slowly turn down the current (mA) 

i) Turn the coarse adjust dial on ‘click’, pause, then turn it again. 
ii)  Turn the coarse adjust knob all the way counterclockwise, to 10 mA 

c) Then, slowly turn down the voltage (kV) 
i) Turn the coarse adjust dial on ‘click’, pause until the needle stops moving, then turn it again. 
ii)  Turn the coarse adjust knob all the way counterclockwise to 20 kV 

d) Press the red OFF button on the generator control panel. 
3) Remove your sample from the diffractometer 

a) If you must enter the enclosure while the generator is on (because the other side is in use), be sure to survey 
the area with the Geiger counter first. 

b) Leave the cap OFF of the sample scatter shield 
4) Close the enclosure doors. 
5) Record your instrument usage in the electronic log book on the computer by the door. 
 
Please note:  

·  You should reserve instrument time using the Faces online scheduling system; you may access it through 
http://prism.mit.edu/xray 

·  If a person is 15 minutes late for their reserved time slot, they forfeit that reservation 
·  Failure to show up for reserved instrument time may result in a penalty, at the sole discretion of CMSE 

staff, such as your account being charged for that time anyway 
o If you want to cancel an appointment, you must do so 12 hours before the start of your time slot in 

order to avoid a penalty 
·  Failure to log your instrument use may result in a penalty, at the sole discretion of CMSE staff, usually a 

$30 surcharge 
o such penalties are more likely for repeat offenses 

·  Any sample left in the lab will be disposed of and the sample holder confiscated.  
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APPENDIX A: Selecting Slits for Your Experiment 
 
The divergence, scatter, and receiving slits define the X-ray beam and affect the resolution, intensity, and background noise 
observed in your diffraction pattern.  
 
The most common configuration for the Rigaku diffractometers includes 0.5 or 1° DS and SS and a 0.3mm RS. Note that the 
DS and SS slits are defined in terms of an angle (°), while the RS is defined in terms of its width (mm).  
 
THE DIVERGENCE SLIT 
The divergence slit (DS) limits the divergence of the X-ray beam produced by the X-ray tube. The main purpose of the DS is to 
make sure that as much of the sample is irradiated as possible without the beam falling off the sample: the beam length is a 
function of the divergence angle a and the incident angle q. 
 
Figure 1 shows how the irradiated length varies with angle 2theta for different sizes of DS; these numbers are also summarized 
in Table I.  
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Figure 1. The plots above show how the length of the X-ray beam changes with the 2theta for different sizes of DS. Note that 
for most experiments, the incident angle Theta is half that of the detector angle 2Theta.   
 
Table I. Tabulated data from Fig 1, showing how the beam length changes for different sizes of DS and different detector 
angles, 2Theta. These calculations assume standard theta/2Theta geometry where the detector angle 2Theta is exactly twice the 
incident angle, Theta. 

 Irradiate Length (mm) for 185mm radius Irradiated Length (mm) for 250mm radius 
2Theta 0.15° DS 0.5° DS 1° DS 2° DS 0.15° DS 0.5° DS 1° DS  2° DS 

1 55.50 185 370 740 75.00 250 500 1000 
10 5.56 18.52 37.05 74.09 7.51 25.03 50.06 100.13 
20 2.79 9.30 18.59 37.19 3.77 12.56 25.13 50.25 
30 1.87 6.24 12.48 24.95 2.53 8.43 16.86 33.72 
40 1.42 4.72 9.44 18.88 1.91 6.38 12.76 25.52 
50 1.15 3.82 7.64 15.28 1.55 5.16 10.32 20.65 
60 0.97 3.23 6.46 12.92 1.31 4.36 8.73 17.45 
70 0.84 2.81 5.63 11.26 1.14 3.80 7.61 15.21 
80 0.75 2.51 5.02 10.05 1.02 3.39 6.79 13.58 
90 0.68 2.28 4.57 9.13 0.93 3.09 6.17 12.34 

100 0.63 2.11 4.21 8.43 0.85 2.85 5.70 11.39 
110 0.59 1.97 3.94 7.88 0.80 2.66 5.33 10.65 

 
“Falling off” (sometimes called beam spill off) refers to a condition where the X-ray beam is larger than the target, and 
therefore irradiates ‘stuff’ other than the sample of interest. When the beam falls off the sample, the sample holder becomes 
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irradiated. This may produce diffraction peaks from the sample holder, and will increase the background intensity and noise. If 
the beam becomes larger than the sample holder, the background intensity and noise will increase even more and artifact peaks 
(aka ghost peaks) may be produced at low angles 2theta.  
 
It is important to choose a small enough DS so that the beam does not fall off of the sample. However, using too small a DS 
will cause an unacceptably small area of the sample to be illuminated at high angles 2theta, producing loss of intensity at high 
angles of 2theta. It is particularly important to maximize the size of the incident beam for thin samples (<1 mm thick). 
 
Note that beam spill off is also an issue for the beam width. The X-ray beam is 12mm high on the sample unless a special 
width restricting mask is inserted into the incident beam path. The beam width does not change with incident angle. 
  
THE SCATTER SLIT 
The scatter slit (SS) is used to eliminate background noise from air scatter and other sources of noise. Judicious use of the SS 
can improve the signal-to-noise ratio by as much as a factor of ten. The SS should be large enough that it does not impinge on 
the diffracted X-ray beam, but only on largely diverging and randomly scattered X-rays.  
 
Air scatter is dominant at low angles of 2theta, where X-rays in the direct beam can be scattered by air molecules, pass over the 
sample and directly into the detector. Air scatter is the cause of typical exponential rise in the background at low angles 2theta. 
 
In general, the SS should be the same size as the DS; however, it is also common to use a SS that is twice the size of the DS. 
The SS should never be smaller than the DS or RS.  
 
If the SS is smaller than the DS, it may begin to block diffracted X-rays, thus reducing the intensity of observed diffraction 
peaks. If the SS is larger than the DS, it will allow more air scatter and consequently larger background intensity; and it may 
permit certain artifact peaks to enter the detector.  
 
THE RECEIVING SLIT 
When the X-ray beam irradiates the sample, each diffracting crystallite functions as a point source producing a divergent 
Debye ring. The receiving slit (RS) defines what portion of the Debye ring passes through to the detector as a signal. Using a 
smaller RS can produce greater peak resolution at the expense of overall intensity. Contrariwise, a larger RS will offer better 
intensity in the diffraction pattern at the expense of peak resolution.  
 
Peak resolution is a function of the width of the diffracted peak (usually defined as the full-width at half-maximum intensity 
FWHM). A better peak resolution (smaller FWHM) will allow peaks that are close together to be individually resolved. 
Improved resolution (smaller RS) is important for resolving patterns with many overlapping peaks and for providing accurate 
peak positions for indexing and cell refinement. Greater intensity (larger RS) is important when looking for trace impurities, 
thin films, and many nanoparticles.  
 
Table II  compares the trade-off between peak width and intensity for different combinations of DS and RS using the (220) 
peak of Si. The � d  is the difference between the observed peak location and the NIST certified peak location. The RS is the 
dominant factor determining the peak width until the DS is � 2 deg.  
 185mm radius 250mm radius 
DS (°) RS (mm) � d (Å) Area (cps) FWHM (°) � d (Å) Area (cps) FWHM (°) Shape Skew 
1/6 0.15    0.0007 6614 0.074 0.556 0.002 
 0.3    0.0007 12786 0.097 0.449 0.126 
 0.6    0.0002 21919 0.118 0.411 0.028 
0.5 0.15 -0.0017 40111 0.093 0.0004 23190 0.076 0.586 0.197 
 0.3 -0.0018 51021 0.109 0.0006 42384 0.095 0.455 0.182 
 0.6    0.0001 70948 0.122 0.386 0.147 
1 0.15    0.0003 48829 0.077 0.623 0.137 
 0.3 0.0018 123237 0.108 0.0004 91242 0.096 0.476 0.153 
 0.6 0.0007 196828 0.150 0 152240 0.123 0.362 0.070 
2 0.15    0.0009 89840 0.097 0.473 0.120 
 0.03    0.0010 170999 0.112 0.410 0.158 
 0.6    0.0006 282531 0.138 0.345 0.070 
3 0.15    0.0014 92901 0.098 0.472 0.201 
 0.3    0.0011 176336 0.113 0.426 0.126 
 0.6    0.0007 288407 0.137 0.364 0.064 
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Table III. Varying SS slits for the combination DS=2, RS=0.3 
SS d (A) Area FWHM Shape Skew 
0.15 1.9196 20003 0.119 0.336 0.214 
0.5 1.9197 70426 0.113 0.424 0.148 
1 1.9200 142763 0.118 0.413 0.155 
2 1.9206 265739 0.136 0.350 0.097 
4 1.9206 282968 0.136 0.350 0.123 
 
THE MONOCHROMATOR RECEIVING SLIT 
The monochromator receiving slit (RSM) is placed between the monochromator and detector on the receiving side of the 
diffractometer. It is used to assist the monochromator in removing K-beta, W-contamination, and other spurious wavelengths 
of radiation, as illustrated in Figure 2. It is only necessary when strong diffraction peaks produce noticeable K-beta and W lines 
in the diffraction data, or when the sample fluoresces under the incident radiation producing an unacceptably high background. 
The 0.45 mm RSM is sufficient to remove K-beta and W lines from the diffraction pattern. A finer RSM slit is required only 
when background radiation is particularly troublesome and must be removed from the pattern. However, finer RSM slits also 
significantly reduce the overall intensity of the diffraction pattern. The 0.45 mm RSM only reduces the diffraction strength 
slightly; however, many operators choose note to use it when they value overall signal strength more than the advantage of 
removing spurious reflections. 

   
Figure 2. Comparison of the (111) peak of Si collected with (red) and without (black) the 0.45 RSM slit. 
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Appendix B. Typical Scan Parameters and Data Collection Strategies 
 
The typical scan uses the goniometer in theta/2theta reflectivity mode, where the detector rotates at a rate of 2theta/minute and 
the sample rotates at a rate of theta/minute. Consequently, the incident angle (theta) is always ½ of the angle between the 
incident beam and detector (2theta).  The theta/2theta mode of data collection ensures the optimal focusing condition.  
 
The most common data collection scheme is a continuous mode scan, both axis, from 20 to 70 deg 2theta with a 
scan speed of 1 to 6 deg/min and a step of 0.02 to 0.04 deg. The start and end angles should be changed as 
appropriate for your sample: consult the PDF cards to anticipate if there are low or high angle peaks that should be 
observed to best analyze your sample.  
 
Scan Job Parameters, set in the New Scan Range window, are: 
 
Start and End: determines the start and stop angles for the scan range. 
 For phase ID, a scan from 20 to 70 degrees 2theta is often adequate. The PDF database should be consulted to choose 
the best scan range for the possible phases in a sample. For example, if the PDF cards indicate that a possible constituent phase 
has low angle peaks (below 20 deg 2theta), then that range should be included in the scan-- because few inorganic phases have 
low angle peaks, analysis of the low angle range can be less ambiguous. Likewise, the PDF card may indicate that a sample has 
only 2 or 3 peaks below 70 deg 2theta (common for many metals), and therefore  a higher stop angle may be dictated—it is 
very hard to conclusively determine that a phase is present from only 2 diffraction peaks.  
 If the specified start or stop angles are outside the minimum and maximum limits dictated in the Parameters menu, 
then the angle will automatically be changed to the min/max angle.  
 
Step: The step size for the scan, from 0.002 deg/step to 90 deg/step in 0.002 deg/step increments. Typical 
values are 0.01 to 0.04 deg/step.  

·  In continuous mode, the sampling interval determines the range over which intensity is added together to define a 
datum point. A larger sampling interval results in more photon counts over a longer range being added together for 
each datum point, and therefore may produce greater intensity in the pattern. However, a larger sampling interval will 
produce less sharply defined transitions from peak intensity to background intensity and lower spatial resolution 
between close or overlapping diffraction peaks. The sampling interval in continuous mode therefore produces a 
trade-off between intensity and resolution 

·  In step mode, the sampling interval determines the distance between successive detector positions at which intensity 
is measured. A larger step size reduces the total scan time, but also produces lower spatial resolution. The sampling 
interval in step mode therefore produces a trade-off between resolution and scan time. 

 
Mode: can be either continuous or step.  

·  In continuous mode, the detector moves at a constant rate (the scan speed). The counts observed over a specified 
range (the sampling interval) are added together to define a datum point. For example, the data might record 874 
counts/sec at 10.02 deg 2theta; this actually indicates that 874 counts/sec were observed over the range of 10.01 to 
10.03 (assuming a 0.02 deg sampling interval).  

·  In step mode, the detector is moved to a specified position and then sits there counting photons for the specified time 
(the count time). The distances between each detector position is specified by the sampling interval.  

The difference between either mode is very subtle, and does not actually affect the suitability of the data for 99% of analyses. 
One rule of thumb is to use continuous mode for faster scans and use step mode for longer scans. 
 
Additional Detail 
 In continuous mode, the position is slightly less precise because intensity is integrated over an interval; for example, if the 
counts at 10.01 deg 2theta were 10 cps, and the counts at 10.03 deg 2theta were 1000 cps, then those data might be recorded as 
500 cps at 10.02 deg 2theta. However, all photons at all detector positions are recorded, possibly producing more precise peak 
intensities (particularly peak height). In step mode, the detector might miss the point of highest intensity: if the detector 
collected 500 cps at 10.02 deg 2theta and 300 cps at 10.04 deg 2theta, it might not accurately represent that the peak maximum 
was at 10.03 deg 2theta with 1000 cps. It might be considered, then, that continuous mode produces more precise intensities 
and also greater intensity, since no position is skipped; and step mode produces more precise positions. However, because most 
diffraction peaks are relatively wide (>0.2 deg 2theta) and the detector does not truly observe just a single infinitely small 
point, but rather a small range, 99% of the time you would not be able to tell the difference between data collected in 
continuous mode or step mode. 
 
One rule of thumb is to use continuous mode for faster scans and use step mode for longer scans. If the count time would be 
less than 1 sec/step in step mode, then consider using continuous mode instead; if the scan speed would be slower than 0.5 
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deg/sec in continuous mode, then consider using step mode instead. This guideline considers the stress on the motor during 
your data collection: the difference between a continuous motion at fast speed versus repeated start/stop motions with little 
resting time, and the difference between having the motor continuously engaged as it moves at a very slow speed versus 
start/stop with a considerable rest between each movement.  
 
Rate (d/m) or Dwell(s): when the mode is continuous, this parameter is scan rate; when the mode is step, 
this parameter is dwell time per step. 

·  Rate (d/m): the rate, in degrees/minute, at which the detector moves to collect the data. The total scan time is merely 
the scan range/scan speed. The allowable range is 0.002 deg/min to 90 deg/min in 0.002 deg/min increments. Most 
data can be reasonably collected with a scan speed of 1 to 5 deg/min. Some samples, particularly strongly crystalline 
samples or single crystals, can be scanned at faster rates; while organic materials or poorly crystalline sample may 
require slower rates.  

·  Dwell (s): the time, in seconds, that the detector spends at each data point counting intensity. The total scan time is 
determined by the (scan range/sampling interval) * count time. Standard settings are 0.5 sec/step to 10 sec/step.  

 
Axis: Can be Both, Detector, Theta, or Rocking psi-tilt.  

·  Both Axis moves both the sample angle (theta) and the detector angle (2theta), collecting data in the optimal 
parafocusing condition. This option should be used for most scans. Also known as a theta:2theta scan. 

·  2theta axis rotates only the detector; the sample position is fixed. This is most often used for Glancing Incidence 
Angle Diffraction when/if the thin film attachment is installed on the diffractometer. Without the thin film attachment, 
the 2theta scan will tend to give broad and misshapen peaks.  

·  Theta rotates only the sample; the detector is fixed.  
·  Rocking psi-tilt  rotates the sample and the detector at a constant rate (unlike a scan of both axis, where the sample 

rotates at a rate equal to ½ the rate at which the detector rotates).  
 
  Psi (or Theta, Detector, or 2Theta): This field varies depending on which scan axis has been chosen.  

·  Psi: Appears when the scan axis is Both. Psi can be used to define an offset between theta and 2theta that is preserved 
during the entire scan. For example, in a normal theta:2theta (i.e. both) scan, when the detector is at 20 degrees 2theta 
the sample would be at 10 degrees theta. If psi were set to 5 degrees, however, then when the detector was at 20 
degrees 2theta the sample would be at 15 degrees theta. This offset would be constant throughout the entire scan. 
Setting a psi offset is useful to avoid single crystal peaks from a thin film substrate.  

·  Theta: Appears when the scan axis is Detector. This defines the fixed sample angle theta in a scan where only the 
detector is moving.  

·  Detector: Appears when the scan axis is Theta. This defines the fixed detector angle 2theta in a scan where only the 
sample moves.    

·  2Theta: Appears when the scan axis is Rocking psi-tilt. This fixes the angle between the detector and the sample. 
Then, as the sample rotates the detector moves at the same rate, keeping a constant angle 2theta between them.    

 
Some Data Collection Strategies 
 

·  If you have a sample with only a few peaks or very specific ranges that you are interested in 
observing, you do not have to scan the entire pattern; you can collect data just from the ranges that 
you are interested in. To do this, you can either list multiple scan ranges in your scan job, or you 
can list multiple scan jobs in your task list. If you define several scan ranges in a single scan job, 
all of those data will be saved in a single file. If you define several scan jobs in your task list, then 
each scan range can have a different filename. This approach will allow you to reduce the total 
scan time by focusing just on the areas of interest.  

o In the Options tab of the New Scan Jobs window, you can tell the computer to wait for 
user input in between the scan segments. The data collection software will then pause after 
the first segment is done, waiting for you to tell it that it is ok to proceed. This is useful if 
you want to make sure the first segment looks good before collecting the rest.   

o In this approach, you make many assumptions about your sample. Be careful that you are 
not ignoring useful data.  
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·  If the signal from a coating is being dominated by a single crystal diffraction peak from the 
substrate, then you can include an angular offset in your data collection to correct for this.  

o The single crystal peak from a substrate will only appear for precisely defined angles 
between the incident beam and detector; for example, the diffraction peak from the planes 
parallel to the substrate surface will only diffract when theta is exactly ½ 2theta (the 
normal parafocusing condition in a theta/2theta scan).  

o To avoid the single crystal peak, in the New Scan Range window you can set “psi”  to a 
non-zero value (assuming that your scan axis is set to “Both Axis” ).  The sample angle 
will then be offset relative to the detector, so that the single crystal does not diffract. You 
can use a rocking curve scan to determine how much of a psi offset is required to avoid the 
single crystal peak. The psi offset should be as small as possible, to avoid distorting the 
peak shapes.  

o The success of this technique assumes that your coating is a randomly oriented 
polycrystalline coating. If not, e.g. if the coating is epitaxial, then this offset might cause 
the peaks from the coating to also not diffract.  

 
·  If reported in the PDF, you can use I/Ic (RIR) values to calculate the ratio of weight fractions of 

phases by comparing the intensities of diffraction peaks.  
o The ratio of the weight fraction from two phases, a and b, is: 
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Where X is the weight fraction, I(hkl) is the measured intensity of the diffraction peak, Irel
(hkl) is 

the relative intensity from the reference pattern for that peak, and RIR is the I/Ic (RIR) value 
from the PDF card.  
o This approach is only semi-quantitative. More information is available in most XRD text 

books, where this method is called the Reference Intensity Ratio Method. 
o This value can be used to determine how much of an impurity phase must be present 

before the intensity of its peak(s) could be observed above the background noise in the 
scan. Therefore, you can then use this information to estimate the detection limit for an 
impurity phase in your diffraction pattern. 

 
·  For unit cell or Rietveld refinement, particularly of high symmetry structures, high angle data is 

often invaluable. High angle data in any case can greatly increase accurate refinement despite 
sample displacement errors. Remember, however, that with the PVC separator shield in place, you 
can at most go to 107 deg 2theta. To collect higher angle data, you must reserve both sides of the 
instrument and then remove the separator shield; in which case the right-hand side can go to 139 
deg 2theta and the left-hand side can go to 154 deg 2theta. Also, consider that the PANalytical 
X’Pert instrument can routinely go to 154 deg 2theta without any special arrangement. 
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